
Save in Picture It! format?
This picture was originally opened in a file format other than .MIX. 
It was converted to the .MIX format so that you could work on it in Picture It!.

Click If you want to

Yes Save the current picture in
the .MIX file format.

Yes to 
All

Saves all open pictures in 
the .MIX file format.

No Save your picture in its 
original file format.

Changing monitor settings
Click If you want to

Yes Change your display 
settings and restart your 
computer.

No Retain your current display 
settings.

Save changes
Click If you want to

Yes Save your picture, including
all your changes.

No Close your picture without 
saving your changes.

Tell me more about connecting devices
The device or drive you have selected is not available.
Verify that:

The disk is in the drive.
Your computer is connected to the device.

For more information on connecting drives and devices, refer to your computer's documentation.



Low disk space
Your computer is running out of disk space and you may not be able to save your work. Picture It! 
needs 30 to 50 megabytes of storage space on the hard drive of your computer. 
To free up disk space, you can:

Delete any unnecessary files from your computer's hard drive.
Empty the Recycle Bin.
Move files to a removable disk or another hard drive.



Cannot open picture
If you created or worked on your picture in another program, its file format will be other 
than .MIX.
Explore the different file types Picture It! can open. If you don't see your file type listed:
1 Start the program you used to originally create the picture.
2 Open your picture.
3 Save it again in one of the file formats Picture It! can open, such as .BMP.
          Opening a picture created in a different program  



Tell me about file names
Picture It! file names must be less than 256 characters in length, including spaces and 
punctuation. There may also be characters which are not allowed, depending on your operating 
system. Refer to your operating system's documentation for more information.



How do I free disk space?
You can:

Delete any unnecessary files from your computer's hard drive.
Empty the Recycle Bin.
Move files to a removable disk or another hard drive.



Program could not start
Your computer does not have enough disk space or memory for Picture It! to start. Try:

Closing any open programs.
Deleting any unnecessary files from your computer's hard drive.
Emptying the Recycle Bin.
Moving files to a removable disk or another hard drive.



Reserved file name
Your file name cannot end in .CON, .AUX, .PRN, .LPT*, or .COM*.
Please type a different file name.



Directory not found
The directory path you typed in the Options dialog box, under Path to my pictures, is not valid.
1 On the View menu, click Options.
2 You can either:

In Path to my pictures, type a new path.
—or—

Click Browse, and then click the folder you want.



Low memory
Your computer is running out of memory.
To regain more memory:

Quit all unnecessary programs on your computer.
—or—

Close some of your pictures in Picture It!





Making combined pictures more compatible
The pictures you combine in a collage may have different tints, resolutions, focus, or other 
variations. 
You can try some of the following methods to give the objects you're using a more uniform look.
          Softening the edges  
          Correcting the tint  

            Changing the brightness or contrast  



Copying an object
1 On the Stack, click the object you want to copy.
            Where's the Stack?  
2 On the Edit menu, click Copy.
3 On the Edit menu, click Paste.

To make than one copy of the object, click Paste as many times as you'd like.
4 Move the copy to its new position.
            How?  



Adding color to a black and white picture
To add color to a black and white picture, use the Tint tool.
1 On the Workbench, click Paint & Color Effects, and then click Correct Tint.
2 On the Tint tool, click the color you want to add to the picture.
3 To increase the level of the color you selected, drag the slider to the right.





What you should know about copyrights
Picture It! features make it easy and fun to transform photographs and digital art into unique 
projects of your own. Sooner or later, you'll probably want to include professionally made 
photographs and digital art. Before you do, be aware of the limitations on using these materials.
            What is a copyright?  
            How should I take copyrights into account?  



What is a copyright?
A copyright gives exclusive ownership rights to the individual who created an original work. These
rights are protected by U.S. law and international agreements.



How should I take copyrights into account?
In Picture It! whenever you use a picture that you didn't take or a piece of art that you didn't 
make, consider that it may be copyrighted. If you're not sure, ask. It's often quick and easy to 
get permission to use someone else's material, and it can avoid problems down the road.
            Copyrights for professional photographic portraits  
            Copyrights for photographs in published materials  
            Copyrights for online photographs or digital art  



Copyrights for professional photographic portraits
School pictures, wedding photographs, and those holiday pictures taken in department stores are
all generally taken by professional photographers. Before you scan these images for your own 
use, make sure that you get permission from the photographer. 



Copyrights for photographs in published materials
If you want to scan a picture from a magazine or book, or take a picture of something you see in 
a video, get permission from the publisher or check with your copy shop staff first. 



Copyrights for online photographs or digital art
Digital art can be copyrighted just as art in printed sources. Before you download art you find on 
the World Wide Web, make sure you get permission from the author or artist that created the 
work, not just the person who posted it online. 



Mouse and keyboard shortcuts
            Keyboard shortcuts: The basics  
            Keyboard shortcuts: Viewing and editing a picture  
            Mouse shortcuts  



Keyboard shortcuts: Undoing and deleting
To Press

Undo the previous 
action

CTRL+Z

Redo the previous 
action

CTRL+Y

Delete a selected 
item

DELETE

Keyboard shortcuts: Nudging objects
Click in the picture pane before nudging an object.
To nudge something Press

To the left ç
To the right è
Up é
Down ê

Keyboard shortcuts: Opening, saving, printing, and quitting 
Picture It!
To Press

Create a new collage CTRL+N
Open an existing 
picture or collage

CTRL+O

Print part or all of a 
picture

CTRL+P

Save changes to a 
picture

CTRL+S

Quit Picture It! ALT+F4
Open Picture It! 
Help

CTRL+F1



Mouse shortcuts
To Try

Resize an 
object, keeping 
its center

Pressing CTRL 
and dragging a 
Resize handle

Scroll in any 
direction in the
picture pane

If you have a 3-
button mouse, 
pressing the 
middle button 
while moving the 
mouse that 
direction

Skew an object Holding down 
ALT and dragging
a Stretch handle

If you have an IntelliMouse™

To Try

Zoom in Rotating the 
wheel forward

Zoom out Rotating the 
wheel back

Scroll in any 
direction in the
picture pane

Holding down the
wheel while 
moving the 
mouse that 
direction



Keyboard shortcuts: Working in Windows
To Press

Quit Picture It! or 
close a task pane

ALT+F4

Switch to another 
program

ALT+TAB

Switch to the 
Windows Start 
menu

CTRL+ESC



Keyboard shortcuts: Choosing menus and commands
To Press

Highlight the menu 
bar

ALT or F10

After you have highlighted the menu bar, you can do the following:
To Press

Choose the menu or 
command with an 
underlined letter

The key for 
the 
underlined 
letter

Move between menus è or ç
Move between 
commands on a menu

é or ê

Choose a highlighted 
menu or command

ENTER

Cancel the 
highlighted command

ESC

Open Help F1



Keyboard shortcuts: Moving and making choices in task panes
To Press

Move to the next 
option, text box, 
or list box

TAB

Move to the 
previous option

SHIFT+TAB

Move to an option
with an 
underlined letter

ALT+ the key
for the 
underlined 
letter

Move to the first 
item or character
in a list or text 
box

HOME

Move to the last 
item or character
in a list or text 
box

END

Open or close a 
list box

F4

Move between 
items in a list box

é or ê

Choose or clear a 
check box

SPACEBAR

Extend the 
highlight in a text
box one 
character to the 
left or right

SHIFT+ç 
or 
SHIFT+è

Move the 
selected slider 
control left or 
right

ç or è

Extend the 
highlight to the 
last character in 
a text box

SHIFT+END

Extend the 
highlight to the 
first character in
a text box

SHIFT+
HOME

Close the dialog 
box or task pane 
and keep the 
changes you made

ENTER

Close the dialog 
box or task pane 
and not keep the 
changes you made

ESC or 
ALT+F4



Keyboard shortcuts: The basics
            Working in Windows  
            Choosing menus and commands  
            Moving and making choices in task panes  



Keyboard shortcuts: Viewing and editing a picture
            Undoing and deleting  
            Nudging objects  
            Opening, saving, printing, and quitting Picture It!  





Undoing a change
If you Then

Are still in the 
task pane

Click Cancel or 
Reset.

Have clicked 
Done, but made
no other 
changes yet

On the Edit menu, 
click Undo.

Have made 
other changes 
to your project

On the File menu, 
click Return to 
Last Save.
-or-
On the File menu, 
click Close. When 
asked to save, click 
No. Now you can 
reopen your picture.
Caution: You will 
lose whatever work 
you’ve done since 
the last time you 
saved.

Undoing a change
If you Then

Are still in the 
task pane

Click Cancel or 
Reset.

Have clicked Done,
but made no other 
changes yet

On the Edit menu, 
click Undo.

Have made other 
changes to your 
project

Select the object 
that has the 
effect you want to
undo, and then 
return to the task 
pane where you 
added the effect. 
Click the first 
picture in the 
preview list (no 
effect), and then 
click Done.



Softening the edges of an object
1 On the Stack, click the object you want to change.
            Where's the Stack?  
2 On the Workbench, click Edge Effects, and then click Soft Edges.
3 Follow the instructions in the task pane.
Troubleshooting
            What if I change my mind?  





Closing a project
On the Filmstrip, right-click the picture and then click Close.

—or—
On the File menu, click Close.

Tip: To close all the projects that are on the Filmstrip, click Close All on the File menu.



Quitting Picture It!
On the File menu, click Exit.

—or—
Click the small “x” in the upper-right corner of your screen.



Opening a picture of your own
1 On the Workbench, click Get Picture, and then click My Picture.
2 Follow the instructions in the task pane.
Troubleshooting
            What if I don't see any pictures?  
Tips
            Looking for a specific file format  
            Opening more than one picture at a time  
What do you want to do next?
            Fix imperfections  



I don't see any pictures
Here are some things to try if you don't see any pictures in the preview pane:

To look in a different disk drive or folder, click the drive letter and folder name you want 
from the list in step 1 of the My Picture task pane.

To start fresh and look in the default disk drive and folder location, click Cancel and then 
follow the procedure for opening a picture.



Looking for a specific file format
To look for files with a specific file format extension (for example, .BMP), click the file format 
you want from the Display this type of picture list in step 1 on the My Picture task pane.



Opening more than one picture at a time
To open multiple pictures at once, hold down CTRL and click each picture you want. Then click 
Open, or drag them onto the Filmstrip.



Downloading a picture from a digital camera
1 Plug in and turn on your digital camera.
2 On the Workbench, click Get Picture, and then click Digital Camera.
3 Follow the instructions in the task pane.
Troubleshooting
            Digital camera problems  
What do you want to do next?
            Change the picture's size or position  
            Fix imperfections  



Digital camera problems
What is the problem?
            Nothing happened when I downloaded  
            I got a message that there was no camera installed  



No Camera Installed error message
Just plugging in your digital camera isn't enough. Be sure to follow the camera manufacturer's 
directions, and install all the software that was included with your camera.



Nothing happened when I downloaded
Make sure your camera:

Is plugged in securely to your computer.
Is turned on.
Contains fresh batteries.



 



Scanning a picture
1 On the Workbench, click Get Picture, and then click Scan Picture.
2 Follow the instructions in the task pane.
Troubleshooting
            Scanning problems  
Tips
            Tips for better scanning  
            What you should know about copyrights  
What do you want to do next?
            Change the picture size or position  
            Fix imperfections  



Tips for better scanning
Clean the scanner glass with household window cleaner. Make sure it is dry before you place 

your picture on the glass.
Dust your picture before placing it in the scanner. This could save some touchup later on.
If your picture is very light or very dark, try clearing the Correct Brightness and Contrast

check box in the task pane. This feature works best when there is a broad range of contrast in the 
picture.

If you are scanning a physical object, Custom Scan will give you the best results. Do not 
attempt to scan an object that is more than two inches high, as it will be difficult for the scanner 
to focus correctly on anything taller.



Scanning problems
What is the problem?
            Nothing happened when I scanned  
            The scan took a very long time  
            It scanned too much or too little of my picture  
            The scanned image is really washed out  
            The scanned image doesn't look the way it should  
            I got a message there was no scanner installed  
            I got a different error message  
            My computer froze or crashed  



Nothing happened when I scanned
Try scanning with another software program, such as Microsoft Publisher. If you can scan with a 
different program, try reinstalling Picture It! If you still can't scan, try reinstalling your scanner
software.



The scan took a very long time
If you are using a three-pass flatbed scanner to scan a color picture, use Custom Scan instead of
Smart Task Scan. If you're not sure if your scanner is a three-pass model, listen and see if the 
scanning bar makes three complete passes over your picture.
Any scanner can take a long time to scan a complex picture with many objects.



The scanned image doesn't look the way it should
Check README.hlp and see if there is any specific information for your scanner.
You can also call your scanner manufacturer (or visit their World Wide Web page) and check for 
an updated version of their scanning software.



It scanned too much or too little of my picture
If you are using a flatbed scanner, and the color of your scanner lid and your picture edges are 
the same, Picture It! was not able to correctly identify the edges of your picture.
Put your picture on the scanner bed, and cover the entire scanner bed (not just your picture) 
with fabric or paper of a different color.
If you are still having problems, check README.hlp and see if there is any specific information 
for your scanner.



The scanned image is really washed out
If you scanned your picture using the Correct Brightness and Contrast feature, try turning it 
off and scan again.



No scanner installed error message
Just plugging in your scanner isn't enough. Be sure to follow the scanner manufacturer's 
directions, and install all the software that accompanied your scanner.



I got a different error message
The scanning software probably doesn't support the TWAIN calls needed by Picture It! Call your
scanner manufacturer (or visit their World Wide Web page), and check for an updated version of
their scanning software.



My computer froze or crashed
If you are using Smart Task Scan, try using Custom Scan instead. Since some scanners do not 
support the TWAIN calls Picture It! needs for Smart Task Scan, you still may be able to 
successfully scan with Custom Scan.
If you're still experiencing problems, call your scanner manufacturer (or visit their Web page), 
and check for an updated version of their scanning software.



Zooming in or out
1 In the lower-right corner of the main window, find the Zoom And Scroll tool.
2 Click the Zoom In indicator ("A" below) for a closer look, or click the Zoom Out indicator 

("B") to see more of the picture.

After zooming, you'll notice that a box appears inside the Zoom And Scroll tool.
This outlines the part of your picture that appears in the picture pane. To quickly view a 
different part of your picture in the picture pane, click the spot in the small picture where you 
want the center of the box to be. The display in the picture pane will move accordingly.
Note: Zooming in or out does not affect the size of your printed picture.



Using the Tint tool
You can use the Tint tool to increase or decrease the amount of a selected color in your picture.
1 On the ring, click the color you want to add or remove.
2 To increase the level of the color you selected, drag the slider to the right.

—or—
To decrease the level of the color you selected, drag the slider to the left.

Troubleshooting
            What if I change my mind?  



Changing brightness or contrast in part of a picture
        Play movie: Improving contrast  

1 On the Stack, click the object you want to change.
            Where's the Stack?  

2 On the Workbench, click Paint & Color Effects, and then click Brightness & Contrast.
3 You can either
            Use the   Smart Task Fix   to adjust brightness or contrast automatically.  

—or—
            Make adjustments yourself with the Brightness & Contrast tool.  
Troubleshooting
            What if I change my mind?  



Changing brightness or contrast in the whole picture
        Play movie: Improving contrast  

1 On the Workbench tab, click Paint & Color Effects, and then click Brightness & Contrast.
2 If there are two tabs, click the Whole Picture tab.
3 You can either
            Use the   Smart Task Fix   to adjust brightness or contrast automatically.  

—or—
            Make adjustments yourself with the Brightness & Contrast tool.  
Troubleshooting
            What if I change my mind?  



Using the Smart Task Fix to adjust brightness or contrast 
automatically
At the top of the Brightness & Contrast task pane, click Smart Task Fix.
Picture It! will automatically adjust the brightness and contrast.
            What if I don't like the results?  
            How do I get to the   Brightness & Contrast   task pane?  



Using the Brightness & Contrast tool
To make adjustments with the Brightness & Contrast tool, move the yellow and blue balls, either 
by dragging or by clicking the spot on the circle where you want the ball to be.
To adjust Move

Brightness The small blue ball 
toward or away from 
the center of the 
circle.

Contrast The small blue ball 
around the inner 
circle.

Richness (color 
intensity)

The large yellow ball 
around the outer 
circle.

You can fine-tune the brightness ("A" below), contrast ("B"), and richness ("C") by clicking the 
arrows to the right of each box or by typing a number.



Make someone a star
Here's a cropping idea that's guaranteed to make any kid's day: 
1 Get a picture of him, go to the Crop task, and use the star shape. 
2 Print the star with his smiling face in the middle.
            Where's the   Crop   task?  



Where's the Stack?
        Play movie: Stacking Picture It! objects  

The Stack runs along the right side of the screen. It displays all of the objects in a collage. 



Cropping the whole picture
If you want to crop a collage, make sure your project is finished first. Once it's cropped, you 
won't be able to modify the individual objects.
1 On the Workbench, click Size & Position, and then click Crop.
2 If there are two tabs, click the Whole Picture tab.
3 Follow the instructions in the task pane. 
Note: The area inside the pink outline will remain in the picture; everything else will be cut out of
the picture.

Troubleshooting
            What if I change my mind?  
Tips
            Make someone a star  



Cropping part of a picture
1 On the Stack, click the object you want to crop.
            Where's the Stack?  
2 On the Workbench, click Size & Position, and then click Crop.
3 Follow the instructions in the task pane.
Note: The area inside the pink outline will remain in the picture; everything else will be cut out of
the picture.

Troubleshooting
          What if I change my mind?   

Tips
          Make someone a star  



Correcting the tint in the whole picture
        Play movie: Correcting color tint  

1 On the Workbench, click Paint & Color Effects, and then click Correct Tint.
2 If there are two tabs, click the Whole Picture tab.
3 You can either
          Use the   Smart Task Fix   to automatically fix the tint.  

—or—
          Make adjustments yourself with the Tint tool.  

Troubleshooting
          What if I change my mind?  



Correcting the tint in part of a picture
          Play movie: Correcting color tint  

1 On the Stack, click the object you want to change. 
          Where's the Stack?  

2 On the Workbench, click Paint & Color Effects, and then click Correct Tint.
3 You can either
          Use the   Smart Task Fix   to automatically fix the tint.  

—or—
          Make adjustments yourself with the Tint tool.  

Troubleshooting
          What if I change my mind?  



Using the Smart Task Fix to automatically fix the tint
          Play movie: Correcting color tint  

With the Correct Tint task pane open, click something in your picture that should be white. 
Picture It! will automatically fix the tint.
          What if I don't like the results?  
          How do I get to the   Correct Tint   task pane?  



Repairing red eye
1 On the Stack, click the photo you want to touch up.
          Where's the Stack?  

2 On the Workbench, click Touchup, and then click Fix Red Eye.
3 Follow the instructions in the task pane.
Troubleshooting
          What if I change my mind?  



Undoing red eye repair
Click Cancel or Reset.





Picture It! Help
What do you want to do?
          Open, scan, or download a picture  
          Fix imperfections  
          Combine pictures  
          Change something's size or position  
          Work with color  
          Add an edge  
          Print my picture  
          Save my picture  



Opening, scanning, or downloading a picture
What do you want to do? 
          Open a picture  
          Scan a picture  
          Download a picture from a digital camera  
          Download a picture from PhotoNet  



Fixing imperfections
What do you want to do to your picture? 
          Repair red eye  
          Correct the tint  
          Change the brightness or contrast  
          Remove unwanted parts of the picture  



Correcting the tint or color
What do you want to do? 
          My picture has a funny tint to it, and I want to fix it  



Cropping or removing an object from a picture
What do you want to do? 
          Crop the edges of a picture  



Changing something's size or position
What do you want to do? 
          Resize it  
          Move it  
          Rotate it  
          Flip it  
          Stretch it  
          Crop it to a different shape  



Moving an object 
Where do you want to move it? 
          To a different position in the current picture  
          In front of or behind another object  
          To another picture  



Moving an object to another picture
What do you want to move?
          The whole picture (everything that's in the Stack)  
          Part of the picture (a single object in the Stack)  



Flipping something
What do you want to flip?
          The whole picture  
          Part of it  



Rotating something
What do you want rotate?
          The whole picture  
          Part of it  



Working with color
What do you want to do? 
          Correct the tint  
          Change the brightness or contrast  



Adding an edge
What do you want to add? 
          A soft edge  



Printing a picture
What do you want to do? 
          Print a picture on my own printer  



Saving my picture
What do you want to do? 
          Save a picture  
          Close a picture  
          Save a picture as wallpaper  
          Store pictures at PhotoNet  



Saving pictures
What do you want to do? 
          Save a picture  
          Save it with a different name  
          Save it in a different location  
          Save it so I can use it in a different program  



Combining pictures
First open the pictures you want to combine. Then combine pictures and arrange them the way 
you want them.
What do you want to do? 
          Open a picture  
          Move a picture or object to another picture  
          See some tips for making your pictures work together  



Opening a picture
What do you want to open? 
          One of my own pictures  



Changing the color of your picture
What do you want to do?
          Add color to a black and white picture  



Correcting the tint
What do you want to correct?
          The whole picture  
          Part of it  



Changing the brightness or contrast
What do you want to change?
          The whole picture  
          Part of it  



Cropping a picture
What do you want to crop?
          The whole picture  
          Part of it  



Resizing objects
What do you want to do? 
          Resize it  
          Stretch it  
          Crop it to a different shape  



Moving, flipping, or rotating something
What do you want to do? 
          Move it  
          Rotate it  
          Flip it  





How do I move or resize the cookie cutter shape?
          Play movie: Moving and resizing  

The area inside of the cookie cutter shape defines the area you want to cut out of the picture. 
To change which part of the picture you keep, move or resize the shape.

To You

Move the 
cookie cutter
shape

Click inside the 
selection box ("A" 
below) and drag it to a 
new position.

Resize the 
height and 
width 
proportion-
ately 

Drag any corner handle
("C" below) inward to 
reduce the size, or 
outward to enlarge it.

Stretch 
either the 
height or 
width 

Drag any side handle 
("D" below) inward to 
reduce the height or 
width, or outward to 
enlarge it.

Tips
To more precisely position the cookie cutter shape, try:
          Keyboard shortcuts: Changing and nudging items  



What's the Retriever?
When you click a picture on the Filmstrip, the Retriever appears. The Retriever previews what 
that picture would look like if you switched to it, and includes a "mini-Stack" showing all the 
objects in the picture.
To add a single object from the picture in the Retriever, drag the object from the Stack in the 
Retriever ("A" below) to the picture pane.
To replace, or "switch" the picture in the picture pane with the picture in the Retriever, click 
Switch to ("B" below).
To add the whole picture in the Retriever to the picture in the picture pane, click the button in 
the lower-right corner of the Retriever ("D" below).



Should I save my project as a finished or active collage?
A finished collage is smaller than an active collage. It is the electronic equivalent of permanently 
"gluing down" all the objects in your collage, and you will not be able to do things such as move 
objects in your picture later on.
Smaller files:

Require less storage space on your hard drive.
Print out faster.
Can be transmitted faster in an e-mail message.



How do I drag an object on the Stack?
          Play movie: Stacking Picture It! objects  

The higher up an object is in the Stack, the closer to the front it appears in the picture pane.
To move something forward, click it and drag it upwards in the Stack. To move it backward, click 
and drag it downward. 



How do I trace the eyes?
If you haven't already, zoom in on the eyes. Then click where you want to start tracing, and drag 
along the inside edges of the eye. Don't worry about returning to the exact spot you started; 
Picture It! will connect the starting and ending points for you. 
If you aren't totally satisfied with the results, follow the instructions in the task pane to adjust 
the edge.
Tips
          How do I zoom in to see more detail?  



How do I zoom in to see more detail?
Find the Zoom And Scroll tool in the lower-right corner of your screen. Click the Zoom In 
indicator ("A" below) as many times as necessary to get a good look at the object you want.

If you've zoomed to a part of the picture that doesn't include the object, use the Scroll tool 
("C" below) to go right where you want. Click the area you want to see, and the Scroll tool takes 
you there. 



What if the eye discoloration isn't red?
The term "red eye" refers to any discoloration in the picture caused by the flash reflecting off 
of the eye. In humans, this discoloration is usually red. In animals, it's often green.
Whatever the discoloration is, follow the same directions in the task pane.





Should I use Smart Task Scan or Your scanner software?
Click Smart Task Scan if you are using a flatbed scanner, and if:

You want Picture It! to automatically locate the edges of your picture.
You want Picture It! to select the best resolution.
Your picture is in good condition.

Click Your scanner software if:
You want to control the settings for resolution, picture region, brightness, contrast, and 

color adjustment.
Your picture is in poor condition and will require fine-tuning.



How do I scan with a flatbed scanner?
1 Lift the scanner lid.
2 Place the picture face down on the scanner glass.
3 Close the scanner lid.
Note: Your picture doesn't need to be even with the edge of the scanner. If you are using Smart
Task Scan, Picture It! will automatically straighten the picture. You can also rotate the picture 
in Picture It! after the scan is complete.



How do I scan with a sheet-fed or hand-held scanner?
Follow the detailed instructions provided by your scanner manufacturer.



How to describe your scanner to Picture It!
Click If your scanner

Flatbed 
scanner

Has a flat glass surface 
on which to lay the 
picture during scanning.

Other Is a sheet-fed, hand-
held, or film scanner. If 
you're unsure, click this 
option.

Do you want Picture It! to adjust the level, size, and 
brightness/contrast after the scan is complete?
Click Yes if you want some help adjusting the straightness (level), crop size, or brightness and 
contrast of your picture as soon as the scan is complete.
Click No if you want to wait and make changes later in Picture It!



Should I use Smart Task Download or Custom Download?
Click If you want to

Smart 
Task 
Download

Quickly and easily 
download your pictures.

Custom 
Download

Control the settings for
deleting pictures, 
downloading pictures, 
and changing camera 
settings.



How do I move, rotate, and resize an object?
          Play movie: Moving and resizing  

Although you may not be able to see your whole picture, the selection box ("A" below) shows you 
its location and size. You can then move or resize it to change which part of it shows.

To You

Move an object Click inside the 
selection box 
("A" below) and 
drag it to a new 
position.

Rotate an object Drag the large 
green ball ("B" 
below) to the 
right or left.

Resize the 
height and width
proportionately

Drag any corner 
handle ("C" 
below) inward to 
reduce the size, 
or outward to 
enlarge it.

Stretch either 
the height or 
width

Drag any side 
handle ("D" 
below) inward to 
reduce the 
height or width, 
or outward to 
enlarge it.

Tips
To more precisely position an object, try:
          Keyboard shortcuts: Changing and nudging items  



Where's the Filmstrip?
The Filmstrip is located near the bottom of your screen, below the canvas and to the right of the
task pane. All the pictures you opened during the current session are shown on the Filmstrip.



How do I use the Brightness & Contrast tool?
          Play movie: Improving contrast  

To adjust Click or drag

Brightness The small blue ball 
toward or away from 
the center of the 
circle

Contrast The small blue ball 
around the inner circle

Richness 
(color 
intensity) 

The large yellow ball 
around the outer circle

What if I have a black and white picture?
          Play movie: Correcting color tint  

If you want to add color to a black and white photograph, use the Tint tool.
Related topics
          Correcting the tint  



What if there's no white in my picture?
Try zooming in to see if you can find a white spot in your picture.
On the Zoom tool located in the lower-right corner of your screen, click the Zoom In indicator 
("A" below). Move the Scroll box ("C" below) until it is over a part of your picture that contains 
some light areas, and click a white spot in the picture.
If you still can't see any white spots, click on a gray area instead. If you don't like the Smart 
Task Fix result, click Reset and then use the Tint tool to adjust the colors in your picture 
yourself.



How do I use the Tint tool?
          Play movie: Correcting color tint  

The Tint tool increases or decreases the level of a selected color in your picture.
On the ring, click the color you want to add or remove. If you want to increase the amount of the
color you selected, drag the slider to the right. If you want to decrease the amount of the color 
you selected, drag the slider to the left.



What's color management?
Color management is a Windows feature that helps your printer match the colors that appear on 
your screen.
If you don't like the results, click in the Use Color Management box to uncheck it, and try 
printing again.
If the Use Color Management check box is grayed, don't worry about it. Some printers don't 
support the type of color management that Picture It! uses, and some don't support it at all.



How do I change the position of the object?
          Play movie: Moving and resizing  
          Play movie: Stacking Picture It! objects  

To You

Move an 
object

Click inside the 
selection box ("A" 
below) and drag it to 
a new position.

Resize the 
height and 
width 
proportion-
ately

Drag any corner 
handle ("C" below) 
inward to reduce the 
size, or outward to 
enlarge it.

Resize an 
object and 
retain the 
same center 
point

Press CTRL, and drag 
any corner handle ("C"
below) inward to 
reduce the size, or 
outward to enlarge it.

Stretch either
the height or 
width

Drag any side handle 
("D" below) inward to 
reduce the height or 
width, or outward to 
enlarge it.

Rotate an 
object

Drag the large green 
ball ("B" below) 
clockwise or 
counterclockwise.

Skew an 
object

Press ALT, and drag 
any top or bottom 
handle.

Move an 
object in front
of another

On the Stack, drag 
the object up to the 
one you want to put it 
in front of.

Move an 
object behind 
another

On the Stack, drag 
the object down to 
the one you want to 
put it behind.

Tips



To more precisely position an object, try:
          Keyboard shortcuts: Changing and nudging items  

Related topics
          Where's the Stack?  



New command (File menu)
Starts a new project.



Open command (File menu)
Opens or finds a picture and displays it in the picture pane.



Close command (File menu)
Closes the picture displayed in the picture pane. 



Close All command (File menu)
Closes all open pictures.



Save command (File menu)
Saves the picture in the picture pane with its existing name, location, and file format.



Save As command (File menu)
Saves the picture in the picture pane with the file name, location, and format you specify. 



Save All command (File menu)
Saves all open pictures (all pictures displayed on the Filmstrip).



Return to Last Save command (File menu)
Undoes any changes you've made to a picture since last saving.



Scan Picture command (File menu)
Scans a picture into Picture It!



Digital Camera command (File menu)
Loads a digital camera picture into Picture It!



Print command (File menu)
Prints the picture displayed in the picture pane.



File list (File menu)
Lists the most recently opened files.



Exit command (File menu)
Closes Picture It!



Undo command (Edit menu)
Reverses or deletes your last action.



Redo command (Edit menu)
Reinstates your last action. This is only available after you have used the Undo command.



Cut command (Edit menu)
Removes selected pictures or words from their location on the picture pane.



Copy command (Edit menu)
Copies selected pictures or words on the picture pane.



Paste command (Edit menu)
Places an item that you have cut or copied onto the picture pane.



Delete command (Edit menu)
Deletes the selected object. 



Select All command (Edit menu)
Selects an entire picture or collage.



Stack command (View menu)
Displays or hides the Stack.



Object Handles command (View menu)
Displays or hides the object handles and the rotate lever.



Microsoft Picture It! Help Topics command (Help menu)
Displays the online Help contents screen.



Show Index command (Help menu)
Displays the online Help index screen.



Introduction To Picture It! command (Help menu)
Launches an introductory demonstration of Picture It! features.



About Microsoft Picture It! command (Help menu)
Displays the version number of Picture It!, copyright information, and your copy's serial number.



Picture pane
In Picture It! the picture pane displays your picture or collage. It's where you do most of your 
work.
If the picture is too big to fit in the picture pane, either change its size with the Zoom tool or 
scroll the picture up and down and side to side.



Preview pane
The preview pane shows either previews or file names of the pictures in the current location. 
To work with a picture, click and drag the file name or preview to the Filmstrip, or double-click 
the picture and it will appear on the Filmstrip.



Move Forward Or Backward command (Edit menu)
Opens a task pane to change an object's place on the Stack.



Menu Previews command (View menu)
Displays or hides previews for the buttons on the Workbench.



Display Settings command (View menu)
Opens the Windows Display Properties dialog box to the Settings tab.



Stack
          Play movie: Stacking Picture It! objects  

The Stack displays all of the objects in a collage.
The higher up an object is in the Stack, the closer to the front it appears in the picture pane.
To move something forward, click it and drag it upward in the Stack. To move it backward, click 
and drag it downwards.



Zoom And Scroll tool
Click the Zoom In indicator ("A" below) as many times as necessary to get a good look at the 
object you want. 
If you've zoomed to a part of the picture that doesn't include the object, use the Scroll tool 
("C") to go right where you want. Click the area you want to see, and the Scroll tool takes you 
there.



Filmstrip
This is where all your open pictures are displayed.

To display a picture on the Filmstrip, double-click it and it appears in the picture pane.
To add a picture on the Filmstrip to the picture that’s currently displayed in the picture 

pane, drag it from the Filmstrip to the picture pane.
          How?  



Microsoft Picture It! Home Page
Connects you to the Picture It! Home Page on the World Wide Web.



Microsoft Home Page
Connects you to the Microsoft Home Page on the World Wide Web.



Display Settings dialog box
Optimum settings to run Picture It! are 24-bit color, and minimum 800 by 600 pixels. 
Warning: After changing settings you may need to restart your computer. You should save your 
work and close any other programs before doing so.
To change your settings:
1 In the Color palette box, click High Color (16 bit) or higher.
2 In the Desktop area box, move the slider to at least 800 by 600 pixels.
3 Click Apply, and then OK. If necessary, follow the directions for restarting your computer. 



Export Options dialog box
Convert to lists the available color options. Some options (for example, True Color) take up hard 
disk space.
Compression type lists the available compression options for saving hard disk space.
Compression level sets the desired level, either by dragging the slider or typing in the box.
Export size lists available sizes for your picture.
Custom size allows you to define your own size by typing numbers in the Width and Height boxes.
Maintain aspect ratio keeps the original proportions of your picture as you adjust the size.



Options
Use this dialog box to change Picture It! settings. 
Settings with a check mark are turned on. Click them if you want to turn them off.
Show Introduction displays the Introduction to Picture It! that you see the first time you run 
Picture It!
Play Picture It! sounds turns on sounds for various mouse and keyboard actions.
Show Tool Tips displays small labels over screen controls when you hold the pointer over them.
Show alert to change screen settings displays an alert message if your screen resolution 
settings are not optimized for Picture It! The alert message gives you the option of automatically
changing the settings.
Path to my pictures is the place Picture It! looks first when you choose the My Picture command
from the Get Picture button. 
Browse displays the contents of your computer’s hard drive. From here you can select the path to
your pictures.
Require CTRL to zoom with Microsoft IntelliMouse changes the wheel action of the Microsoft 
IntelliMouse. When this box is unchecked, rolling the wheel zooms in or out of a picture. When 
checked, rolling the wheel scrolls up or down, and rolling the wheel while holding down the CTRL 
key zooms in or out.
If you do not have the Microsoft IntelliMouse installed, this option does not appear.
Advanced options displays another dialog box with options for picture resolution and 
compression.



Advanced Options
Use this dialog box to change resolution and compression settings for Picture It!
Settings with a check mark are turned on. Click them if you want to turn them off.
Resolution determines the visual quality of the picture you are working on.
Professional is the highest quality but uses the most disk space. Photographic is in the middle, 
and Computer Display is the lowest quality but uses less disk space.
Compression determines the quality of the picture being saved.
Higher compression results in lower quality but saves disk space, and lower (or no) compression 
offers higher quality but uses more disk space.



Opening a picture created by a different program
1 On the Workbench, click Get Picture, and then click My Picture.
2 In step 1, make sure All Picture Files is visible in the Display this type of picture box. If it 

is not, click the arrow on the right of the Display this type of picture box, and then click 
the file format you want from the list.
Note: If you still can’t see your picture in the preview pane, then Picture It! cannot open that
file type. Start the program that was used to create the picture, open it, and save the 
picture again in a file format Picture It! can open, such as .BMP.

3 Follow the remaining instructions in the task pane, and then click Open.



Switching to another open picture
On the Filmstrip, double-click the picture you want to view in the picture pane.



Setting your picture size and orientation
In step 1, click Portrait if you want your picture to be taller than it is wide, or Landscape if you 
want it to be wider than it is tall.
In step 2, click the print size you want for your picture. You can choose a standard photographic 
size such as 4 x 6, or you can choose Fit to Page so your picture fill as much of the page as 
possible when it is printed. If you want your picture to be a specific dimension, click Custom 
Size, and type the size you want in the Height and Width boxes.





Saving a picture
On the Workbench, click Save, Print, & Send, and then click Save.

Note: If you are saving your picture for the first time, or if you opened it with a file format 
other than .MIX, follow the instructions in the task pane.

Troubleshooting
          Saving problems  

Tips
          Which file format should I use?  
          When should I use Save options?  



Saving a picture with a new name
Saving a picture with a new name creates a copy of the picture.
1 On the Workbench, click Save, Print, & Send, and then click Save As.
2 In step 3, type a new name for your picture.
3 Click Save.
Troubleshooting
          Saving problems  

Tips
          Which file format should I use?  
          When should I use Save options?  



Saving a picture in a different place
1 On the Workbench, click Save, Print, & Send, and then click Save As.
2 In step 1, click the arrow on the right of the Click a folder box, and click a disk drive from 

the list. Then click a folder from the list.
3 Click Save.
Troubleshooting
          Saving problems  

Tips
          What file format should I use?  
          When should I use Save options?  



Saving a picture for use in a different program
1 On the Workbench, click Save, Print, & Send, and then click Save As.
2 In step 2, click the arrow on the right of the Save as this type box, and then click the file 

format you want from the list.
3 Click Save.
Troubleshooting
          Saving problems  

Tips
          Which file format should I use?  
          When should I use Save options?  



Saving problems
What is the problem?
          My computer’s out of storage space  
          I saw a No Write Access message  
          I saw a Device Not Available message  



My computer's out of storage space
If you see a message that says something like “Not enough disk space," you can try:

Saving your picture to a different disk drive, such as a floppy, a second hard drive, or a 
removable Zip drive. In step 1 of the Save As task pane, click the arrow on the right of the Click a 
folder box, and then click the drive you want. Click a folder from the list, and then click Save.

Note: A floppy disk may not have enough space to hold a picture that contains a large number
of objects.

Deleting any unnecessary files on your disk drive, and then saving your picture again. A good 
place to check for unnecessary files is the Temp folder in your Win95 folder.

Emptying the Recycle Bin on your desktop, and then saving your picture again.



I saw a No Write Access message
If you get a message that says something like “Cannot write to the disk," the device is probably 
write-protected. If you’re saving to a:

Floppy disk, take it out of the drive. Turn it over and push the write-protection slider 
towards the middle of the disk.

Zip disk, use the Zip utility to remove the write protection.



I saw a Device Not Available message
If you get a message that says something like “Device not available," it could be that:

There’s no disk in your floppy or Zip drive. Insert a disk, and try saving again.
The device is turned off or has been disconnected from your computer. Turn it on, or 

reconnect the device.



Which file format should I use?
If you are planning on using your picture in a program other than Picture It!, you’ll probably need 
to save it in a file format other than .MIX.
You can save your pictures in any of the file formats listed in the table below. The most common 
programs or uses for each file format are also listed to help you decide the format you want.

File 
extensio
n

File format Programs/ 
Common uses

.BMP Windows 
bitmap

Microsoft 
Paint. Often 
used for 
desktop 
backgrounds.

.FPX Kodak 
FLASHPIX

Some newer 
imaging 
applications. 
Found on 
high-quality 
photo CD-
ROMs, and 
very similar 
to the 
Picture 
It! .MIX 
format.

.JPG JPEG (Joint 
Photo-      
graphic 
Expert 
Group)

Very common,
compressed 
file format 
that works 
well for 
photos. 
Because 
these files 
are quite 
small, use for
e-mail or 
posting to 
Web sites.

.PNG Portable 
Network 
Graphics

Supported by
newer 
imaging 
applications. 
Works well 
for photos, 
clip art, and 
sending in e-
mail.

.TIF Tagged 
Image File 
Format

Supported by
most imaging 
applications. 
Used for 
some clip art 
CD-ROMs.

.GIF Graphics 
Inter-      
change 
Format

Palettized 
images, often
dithered, 
best used for
clip art and 



“solid” images
rather than 
for photos. 

.PCX PC 
Paintbrush

Older 
graphics file 
format.

.TGA Targa Older 
graphics file 
format.

When should I use Save options?
If you are saving your picture with a file format other than .MIX or .FPX, you can click Options 
on the Save As task pane to specify any of the following settings:

Use To

Convert to Change to a 
different color 
option.

Export Size Select from a 
list of 
proportional 
image sizes (in 
pixels). The 
higher the 
numbers, the 
greater the size.
If you’re 
printing, use high
numbers. If 
you’re sending in 
e-mail or size is 
a problem, use 
smaller numbers.

Compression 
type

Select a 
compression 
type.

Custom size Specify the 
exact image 
dimensions (in 
pixels).

Width & Height Specify the 
image height and
width (in pixels).

Maintain aspect
ratio

Maintain the 
original 
proportions of 
the image. If 
unchecked, you 
can change the 
height and width
separately to 
stretch or 
squash the 
picture.

Compression 
level

Increase or 
decrease the 
degree of image 



compression. 
Increasing the 
compression 
level reduces the
image quality as 
well as the file 
size.

Closing a picture
On the Filmstrip, right-click the picture, and then click Close.

—or—
On the Workbench, click Save, Print, & Send, and then click Close This Picture.



Saving a picture as wallpaper
When you save the current picture as wallpaper, its size and color depth are optimized for your 
current display settings.
1 On the Workbench, click Save, Print, & Send, and then click Save As Wallpaper.
2 Follow the instructions in the task pane. 



Changing the file format of a picture
The standard file format for Picture It! is a .MIX file, but you can easily change a picture to a 
different file format.
1 On the Workbench, click Save, Print, & Send, and then click Save As.
2 Follow the instructions in the task pane. In step 2, click the small arrow on the right of the 

Save as this type box, and then click the file format you want.
Tips
          Which file format should I use?  



Cropping to a specific size
1 On the Workbench, click Size & Position, and then click Crop.
2 If necessary, click the rectangle opening.
3 Click Enter exact proportions for the shape.
4 Click the arrows to the right in the width and height boxes for the dimensions you want.
5 Click Done.





Tips for printing on your black-and-white laser printer
If your printouts are darker than you expect, and the white areas look gray, you can try changing
your printer's dithering method. This option may not be available on all printers.
1 Click the Windows Start button.
2 Click Settings, and then click Printers.
3 Right-click the icon for your printer, and then click Properties.
4 Click the Graphics tab.
5 In the Dithering box, click Coarse.
6 Click OK.
Note: You may have to restart Windows for the change to take effect.
For further information and other technical issues, see the Readme file.



Printing the current picture
1 On the Workbench, click Save, Print, & Send, and then click Print This Picture.
2 Follow the instructions in the task pane.
Troubleshooting
          Printing problems  

Tips
          Getting the print size you want  
          Improving your print quality  



Getting the print size you want
In step 4 of the Print This Picture task pane, choose the dimensions for your printout.

To Click

Print your picture
as large as 
possible on the 
page

Fit to Page.

Print your picture
in a standard 
photographic size

The arrow to the 
right of the Click 
a print size box, 
and then click the 
size you want.

Print your picture
with the 
dimensions you 
want

The arrow to the 
right of the Click 
a print size box, 
click Custom Size,
and then type the 
height and width 
you want.

Keep the same 
relative shape of 
your picture

After choosing 
Custom Size, type
in one of the 
dimensions you 
want and click 
Maintain 
proportions.

Improving your print quality
Picture It! makes three print qualities available; good, better, and best. Which options are 
available to you depends on the actual print size of your picture and the resolution of the original
image. The larger the print size, the higher the resolution must be to support “better” and “best”
print qualities.
To see the quality options for the print size you selected, click the arrow to the right of Click a 
print quality box. To change the print size so that more print quality options are available, in step
4 of the Print This Picture task pane, click the arrow to the right of the Click a print size box, 
and click a smaller print size.
Also, using premium grade paper will significantly enhance the quality of your prints. If you have 
trouble locating high quality paper, contact your printer manufacturer for suggested sources.



Printing problems
What is the problem?
          Nothing happened when I printed  
          I wanted my picture on a different size paper  
          My computer displayed a general protection fault, invalid page fault, or exception error   

message



Nothing happened when I printed
Make sure:

Your printer is plugged into a power source.
Your printer is turned on.
Your printer is securely connected to your computer.
The correct printer driver for your printer was installed. Try printing from another 

program to verify.



I wanted my picture on a different size paper
In step 1 of the Print This Picture task pane, click Change printer settings, and then click the 
paper size you want.



My computer displayed a general protection fault, invalid page 
fault, or exception error message

Try printing from another program to see if you can print anything.
Try printing the same picture from another paint program, such as Microsoft Paint.
If another printer is available, try printing the same picture to it.
Print a different picture to the same printer.
Check the age of the printer driver. If it is more than one year old, contact your printer 

manufacturer and try to get an updated one.
If a new driver isn't available, remove the existing printer driver and reinstall it.





Moving an object
          Play movie: Moving and resizing  

1 On the Stack, click the object you want to move.
          Where's the Stack?  

2 In the picture pane, drag the object until you like the new position.
          How?  



Resizing an object
          Play movie: Moving and resizing  

1 On the Stack, click the object you want to resize.
          Where's the Stack?  

2 In the picture pane, drag one of the corner selection handles ("C" below) inward or outward.



Stretching an object
1 On the Stack, click the object you want to stretch.
          Where's the Stack?  

2 In the picture pane, drag the side selection handles ("D" below) outward until you like the 
shape.



Flipping a picture
1 On the Workbench, click Size & Position, and then click Flip.
2 If there are two tabs, click the Whole Picture tab.
3 Follow the instructions in the task pane.
Troubleshooting
          What if I change my mind?  



Flipping part of a picture
1 On the Stack, click the object you want to flip.
          Where's the Stack?  

2 On the Workbench, click Size & Position, and then click Flip.
3 Follow the instructions in the task pane.
Troubleshooting
          What if I change my mind?  



Rotating a picture
          Play movie: Moving and resizing  

1 On the Workbench, click Size & Position, and then click Rotate.
2 If there are two tabs, click the Whole Picture tab.
3 Follow the instructions in the task pane.
Tips
          Rotating the quick way  

Troubleshooting
          What if I change my mind?  



Rotating part of a picture
          Play movie: Moving and resizing  

1 On the Stack, click the object you want to rotate.
          Where's the Stack?  

2 On the Workbench, click Size & Position, and then click Rotate.
3 Follow the instructions in the task pane.
Tips
          Rotating the quick way  

Troubleshooting
          What if I change my mind?  



Moving an object forward or backward
          Play movie: Stacking Picture It! objects  

The higher up an object is in the Stack, the closer to the front it appears in the picture pane.
To move an object forward, click and drag it upward in the Stack. To move it backward, click

and drag it downward in the Stack. 
          Where's the Stack?  



Moving an object to another picture
1 Make sure that both the pictures you’re working with are open on the Filmstrip.
          How do I open a picture?  

2 On the Filmstrip, double-click the picture to which you want to add the object.
3 On the Filmstrip, single-click the picture containing the object you want to add.

The Retriever appears on your screen. It has its own Stack, which shows all the objects in 
the picture.

4 Drag the object you want to move from the Stack in the Retriever to the picture pane.



Moving the whole picture to another picture
1 Make sure that both pictures are open on the Filmstrip.
          How do I open a picture?  

2 On the Filmstrip, double-click the picture to which you want to add the object.
3 Drag the picture you want to add from the Filmstrip to the picture displayed in the picture 

pane.



Rotating the quick way
          Play movie: Moving and resizing  

1 On the Stack, click the object you want to rotate.
          Where's the Stack?  

2 In the picture pane, drag the rotate handle ("B" below) clockwise or counterclockwise.







A medium border.



A narrow border.



A one-page calendar for the month.



A one-page calendar for the quarter.



A one-page calendar for the year.



A selection of ready-made phrases for your edge.



A selection of designer edges.



A selection of textured edges.



A selection of traditional looks for your edge.



A Smart Task that automates the process.



Click a white area in your picture to remove a color cast.



A tool that helps you trace the object.



A tool that helps you edit the cutout.



A wide border.



Additional options for changing text appearance.    



Adds a new dimension of illusion.



Adds a picture that's stored on your computer, scanned, or downloaded from a digital camera.



Adds a picture to My Pictures, from your computer, a network, a disk, or a CD-ROM.



Adds another object to the collage.



Adds new pictures to the slide show.



Adds text.



Adds the entire picture that you selected.



Adds the object that you selected on the Stack.



Aligns text along the left edge.



Aligns text along the right edge.



Allows you to decide how to add new images to your Catalog.



Any descriptive name or phrase for your picture file.



Any descriptive name or phrase for your picture file.



Any descriptive word or phrase. Picture It! will attach the appropriate extension (for example, 
*.MIX, *.GIF, or *.JPG).



Applies a color filter.    



Applies decorative effects.    



Applies distortion automatically. 



Applies the selected level of edge softness to your cutout.



Attaches your finished work to an e-mail message.



Automatically removes red eye (eye discoloration in a photo caused by a camera's flash).



Categories of ready-to-use collages or backgrounds.



Categories of ready-to-use frame patterns.



Categories of ready-to-use mat textures.



Centers text.



Changes an existing slide show.



Changes the hue (color) by moving the ball from 0 to 359 degrees around the ring.



Changes settings for saving the picture file. The settings available depend on the file type you 
select.



Changes settings for the selected printer (refer to your printer documentation).



Changes the description of a picture or folder. 



Changes the edge color.



Changes the frame's color, saturation (color purity), and brightness.



Changes the mat's color, saturation (color purity), and brightness.



Changes the rotation angle in small steps.



Changes the rotation to the angle you type in the box below.



Changes the text color.



Changes the wheel action of the Microsoft IntelliMouse. When this box is unchecked, rolling the 
wheel zooms into or out of a picture. When checked, rolling the wheel scrolls up or down, and 
rolling the wheel while holding down the CTRL key zooms in or out.



Check this box to display a Help topic that suggests what to do after you have placed everything 
on the collage. 



Check this box to have Picture It! try to find the edges of the area you are tracing.



Choose a size for your saved picture.



On the left palette, click a color for your painting. The color appears in the large center square. 
On the right palette, you can click a different shade of that color.



On the left palette, click a finish color. The color appears in the large center square. On the 
right palette, you can click a different shade of that color.



On the left palette, click a start color. The color appears in the large center square. On the right
palette, you can click a different shade of that color. 



Click any words that may be associated with your picture file.



Click any words that may be associated with your picture file.



Click the green flag to begin fixing another scratch.



Click the object that you want to place on the picture pane.



Click this after you have selected the object on the Stack that you want to move forward.



Click this after you have selected the object on the Stack that you want to move backward.



Click for more information.



Click for more information.



Click to adjust the size or shape of your cutout.



Click to narrow the scope of your search after you have clicked More.



Click to create a new folder for your picture files. This new folder will be a subfolder of the 
folder selected above.



Click to display a Help topic that provides information about the task.



Click to enter a description for the saved picture file.



Click to hear the sound you have selected.



Click to broaden your search by related descriptive words. Click again to keep expanding your 
search.



Closes the About dialog box.



Closes the dialog box and cancels any changes you have made.



Closes the dialog box and saves the new options.



Saves your picture as a file of the selected type.



Moves the entire picture to the front of the collage.



Copies picture files from their source location to another location in your Catalog. The picture 
files then exist both in the original location and the destination location.



Copies the selected object and moves it to the front of the collage.



Copyrights and credits.



Creates a cutout in a standard shape to replace the picture.



Creates a cutout in a standard shape.



Creates a greeting card that is folded along the top. Click this option to see a preview.



Creates a greeting card that is folded along the side, like a book. Click this option to see a 
preview.



Creates a link between the original source file and your Catalog picture file. You can view the 
picture file in your Catalog, but it remains in its original location.



Creates a mirror image of the object that you started with (the left becomes the right).



Creates a new folder. 



Creates a shortcut button on your desktop that you can click to view the slide show.



Creates an upside-down image of the object that you started with (the top becomes the bottom).



Customizes the width of the Edge Finder.



Darkens text edges.



Deletes objects from the collage.



Determines the best values for the light and dark areas (contrast) and for the picture's overall 
brightness.



Displays the full text of the software license agreement, with a Print option.



Displays a message when the screen setting is:
Less than 24-bit colors.
Less than 800 x 600 screen resolution.



Displays on the picture pane miniature versions of the pictures.



Displays on the picture pane only the file names of the pictures.



Displays the initial startup screen, which you see the first time you run Picture It!



Displays the names of screen elements when the pointer pauses over them.



Displays the result in miniature.



Distorts text.



To adjust contrast, drag the inner ball clockwise or counterclockwise, and to adjust brightness, 
drag it center to edge. To adjust color intensity, drag the outer ball. The center shows contrast 
and brightness levels. To restore previous settings, click Reset.



To adjust hue, drag the outer ball. To adjust color saturation, drag the inner ball clockwise or 
counterclockwise, and to adjust brightness, drag it center to edge. The center shows your 
starting color and how it changes. To restore previous settings, click Reset.



Drag toward the plus sign to increase the selected color, or toward the minus sign to decrease 
the selected color.



Drag toward the plus sign to increase paint transparency, or toward the minus sign to decrease 
transparency.



Drag toward the plus sign to increase the bend effect, or toward the minus sign to decrease the 
bend effect.



Drag toward the plus sign to increase the effect, or toward the minus sign to decrease it. 



Drag toward the plus sign to increase the compression of a JPG picture, or toward the minus sign 
to decrease compression.



Drag toward the plus sign to increase the direction and strength of the distortion, or toward the
minus sign to decrease it. 



Drag toward the plus sign to increase the slide show speed, or toward the minus sign to decrease 
speed.



Drag toward the plus sign to increase the softness along the edge of the object.



Drag toward the plus sign to increase the effect, or toward the minus sign to decrease the 
effect.



Drag toward the plus sign to make the edge design thicker, or toward the minus sign to make it 
thinner.



Drag toward the plus sign to make the object more transparent, or toward the minus sign to 
make it less transparent.



Drag toward the plus sign to make the picture sharper, or toward the minus sign to make it 
blurrier. 



Drag toward the plus sign to make the shadow more transparent, or toward the minus sign to 
make it less transparent.



Drag toward the plus sign to soften the shadow's edge, or toward the minus sign to harden the 
shadow's edge.



Each ball represents a different brush width. 



Each ball represents a different strength level for the tool that removes dust from your picture.



Each ball represents a different width for the tool that repairs scratches on your picture. 



Each ball represents a different width for the Edge Finder. 



Each ball represents a different width for the edge. 



Emphasizes text edges.



Fills with a color pattern and style. 



Fills with a uniform color and hue. 



Inserts a picture to fill the object. 



High compression.



High resolution (for high-quality prints; uses more hard disk space).



Identifies your scanner type for Picture It!



If no other option is selected, Picture It! adds your pictures based on their current location. 



Moves picture files from their source location to another location in your Catalog. The picture 
files then exist only in the destination location. 



If you choose to enter exact proportions, type a crop height.



If you choose to enter exact proportions, type a crop width.



If you have a flatbed scanner, this automatically locates your picture on the scanner bed, scans 
it at the proper resolution, crops it, and levels it. 



If you select Custom Size, type a custom print height.



If you select Custom Size, type a custom print width.



If you select Custom Size, type a height.



If you select Custom Size, type a width.



Increases or decreases a color's saturation (purity) from 0 to 100 percent in small steps.



Increases or decreases edge softness in small steps.



Increases or decreases edge width in small steps.



Increases or decreases the effect in small steps.



Increases or decreases shadow edge softness in small steps.



Increases or decreases the brightness of the picture from 0 to 100 percent in small steps.



Increases or decreases the compression in small steps.



Increases or decreases the crop shape height in small steps.



Increases or decreases the crop shape width in small steps.



Increases or decreases the distortion in small steps.



Increases or decreases the number of copies that will print.



Increases or decreases the print height.



Increases or decreases the print width.



Increases or decreases the sharpness in small steps.



Increases or decreases transparency in small steps.



Standard paper textures to apply to your brush strokes. Click the arrows to see more. 



Information about configuration, printers, DLLs, fonts, filters, OLE settings, and so on.



Insert your own text into the edge. 



Inserts objects into the text.



Keeps the original proportions as you adjust the size.



Leaves pictures available on the Filmstrip.



You can apply distortion. 



You can trace the object yourself.



Lists file types that Picture It! supports. When you click a file type, only files of that type 
appear. 



Lists print resolution with comparative print time.



Lists ready-to-use collages.



Lists ready-to-use backgrounds for a new collage.



Lists ready-to-use objects.



Lists the available compression options for this file format.



Lists the available drives and folders. 



Lists the available drives.



Lists the available fonts.



Lists the cameras, scanners, and other optical devices that are set up on your computer.



Lists the print resolution options ("Good" prints faster).



Lists the print size options.



Lists the print size units (inches or centimeters).



Lists the printers that are set up on your computer.



The category of PictureArt to be displayed in the picture pane.



Lists the scanners, cameras, and other optical devices that are set up on your computer.



Loads pictures from a digital camera.



Loads pictures from a digital camera, using the software that came with the camera. For more 
information, refer to your digital camera documentation.



 Searches for your pictures in My Pictures catalog using descriptions and dates.



You can add a picture from the Filmstrip or access more options for opening a picture not located
on the Filmstrip.



Low compression.



Low resolution (for small prints; saves hard disk space).



Makes your collage taller than it is wide.



Makes your collage wider than it is tall.



You can manually select discolored eyes. 



Medium compression.



Medium resolution.



Moves or copies a picture into an existing or a new folder. 



Moves or resizes objects in the collage.



No compression.



Not implemented yet



Enter numbers below to fine-tune your changes. 



Opens a picture stored on your computer, a network, a disk, or a CD-ROM.



Opens PictureArt stored on your CD-ROM.



Opens the selected picture onto the picture pane. The replaced picture remains on the Filmstrip.



Opens the slide show so you can watch it.



Click to adjust the size or shape of your cutout.



Options for printing more than one copy.



Options for printing.



Options for saving.



Paints the frame a neutral color.



Paints the frame the complementary color of the picture's main color.



Paints the frame the main color in the picture.



Paints the mat a neutral color.



Paints the mat the complementary color of the picture's main color.



Paints the mat the main color in the picture.



Permanently removes a picture from your computer.



Places the selected picture on the Filmstrip (if it's not already there) and on the picture pane. If
you want to place more than one picture on the Filmstrip, drag the pictures there, and then click 
Done.



Places your cutout on a white background separate from your picture. Click to remove the check 
mark and keep your cutout with your original picture. 



Prints a layout containing a mixture of pictures.



Prints a layout containing more than one copy of the same picture.



Prints the picture.



Prints the project on a page that is taller than it is wide.



Prints the project on a page that is wider than it is tall.



Prints thumbnails of the pictures currently open on the Filmstrip.



Prints thumbnails of your pictures with their names displayed underneath. 



Prints thumbnails of your pictures without displaying names underneath.



Type the text you want to add to your picture.



Removes all pictures from the Filmstrip.



Removes dust or spots from selected areas of your picture.



Removes dust or spots from the entire picture.



Removes the selected picture from the slide show.



Removes the printed thumbnail layout from the picture pane.



Replaces an object in the collage.



Replaces the object with the entire picture that you selected on the Filmstrip.



Replaces the object with the object that you selected on the Stack.



Reset returns the picture to the way it looked before you started changing it. The Reset button 
then changes to Redo. Redo restores the changes you made.



Retains your printed thumbnail layout on the picture pane.



Returns settings to the Picture It! default settings.



Returns settings to their original values.



Returns the last selected picture or folder to the preview pane. 



Returns the picture to the way it looked before your most recent action.



Returns you to the previous task pane to begin a new search.



Returns your picture to the way it looked before your most recent action.



Reverses the fill color pattern and style.



Rotates the object 180 degrees (the top becomes the bottom and the left becomes the right).



Saves any changes you have made and closes the task pane.



Saves hard disk space, but you will need to recreate cutouts if later you want to move or change 
them. 



Lists the available color options for this file format.



Keeps the original proportions as you adjust the size.



Saves the current picture or collage as your desktop wallpaper.



Saves the picture so that cutouts can be moved or changed, but uses more hard disk space.



Saves the postcard on a computer file or to a disk.



Saves the slide show as a PSF file so you can either view it in its own window or insert it into 
documents.



Saves two copies of the slide show, one as a PSF file and the other as an HTML file. Both files 
are linked to the pictures (JPG files).



Scans a picture.



Scans new pictures.



Scans the picture.



Select so that the edge expands and wraps to show more of your picture.



Select the month or months.



Select the time period.



Select the year.



Adjusts the colors so that printout colors approximate those on the screen.



Makes all the text bold.



Makes all the text italic.



Underlines all the text.



Select this to choose your own width and height.



Applies "transparent" as the finish color.



Applies "transparent" as the start color.



Creates a thumbnail in "My Pictures" for easy access and viewing if you are saving on a removable 
disk.



Select to customize the size of your crop shape. 



Selects a category of Cool Edges. 



Selects a ready-to-use object.



Selects all parts of the object except what is currently selected.



Selects one of your own pictures as the background of your new collage.



Selects one of your own pictures or objects.



Selects pictures for a new slide show.



Selects whatever is on the picture pane.



Selects a white background to build your collage on.



Sets the location that you want Picture It! to show first when you click Get Picture, and then 
click My Picture.



Sets the resolution and compression of pictures when you save them as MIX files.



Shows the current directory structure. Select a folder to see the files either listed or displayed
in the picture pane.



The object that you have selected to place on the picture pane.



Standard brush shapes you can use. Click the arrows to see more.



Standard brush strokes you can use. Click the arrows to see more.



Distortion effects you can use. Click the arrows to see more.



Standard edge colors you can use. 



Standard edge shapes you can use. Click the arrows to see more.



Standard fill color patterns you can use. Click the arrows to see more.



Standard fill styles you can use. Click the arrows to see more.



Standard kinds of shadows to apply. Click the arrows to see more.    



Standard shapes to select from. Click the arrows to see more.



Standard text bend patterns you can use. Click the arrows to see more.



Standard text styles you can use. Click the arrows to see more.



Standard tools you can use for distorting. Click the arrows to see more. 



Selects all the picture files displayed so they can be added to your Catalog.    



 #Technical support options.



The yellow ball indicates the color that you are adding to or removing from the selected object.



The beginning date for the picture file search. 



The brightness control: You can enter numbers between -100 and +100. Higher numbers increase 
brightness.



The contrast control: You can enter numbers between -100 and +100. Higher numbers increase 
contrast. 



Color Picker tool: Use this to click a color in your picture if you want to select it as the 
"reference color" before adjusting the color in the object. The reference color is the color that 
changes to match the color you click on the Color tool.



The richness control: You can enter numbers between -100 and +100. Higher numbers increase 
color intensity.



Categories of PictureArt within the main category that you selected.



You scan using the software that came with your scanner. For more help, refer to your scanner's 
documentation.



Traces an object in the picture.



Turns on the sounds that come with Picture It!



Turns the selected object on its side (270 degrees) so that the top points to the left.



Turns the selected object on its side (90 degrees) so that the top points to the right.



Turns the selected object upside down (180 degrees).



Type a beginning date for the picture file search. 



Type a message for the bottom edge.



Type a message for the left edge.



Type a message for the right edge.



Type a message for the top edge.



Type a number to change the distortion direction.



Type an ending date for the picture file search.



Type the date of your picture.



Types of sound that play when your postcard is received.



When Smart Task Scan is being used, this option will attempt to automatically correct the 
brightness and contrast of your picture. 



When the flag is green, clicking it connects the ends of your tracing, and then you can adjust the
lines of the tracing. When the flag is yellow, clicking it finishes the tracing.



When you click Recover an area, whatever you trace next will be added back to the object.



When you click Trim an area, whatever you trace next will be removed from the object.



You can customize the colors for your fill color pattern.



You can enter numbers between -100 and +100. Higher numbers increase shadow transparency.



You can enter numbers between -100 and +100. Higher numbers increase edge softness.



You can enter numbers between -100 and +100. Higher numbers increase transparency.



You can enter numbers between -100 and +100. Higher numbers increase sharpness.



You can enter numbers between -100 and +100. Higher numbers increase the edge softness.



You can enter numbers between -99 and +100. Higher numbers increase edge thickness.



You can further customize the cutout color or fill.



You can further customize the shape and texture of your paintbrush.



You can further customize your color.



You can further customize your colors.



You can further customize your edge.



You can further customize your gradient finish color.



You can further customize your gradient start color.



You can further customize your shadow color.



You can further customize your text shadow. 



You can select a predefined shape for your object.



Categories of ready-to-use KODAK IMAGE MAGIC Custom Creations.



Lists the sizes and formats of high-quality prints of your project that you can order from Kodak.



Makes a 5-by-7-inch print.



Makes an 11-by-14-inch print.



Makes an 8-by-10-inch print.



Initiates the KODAK IMAGE MAGIC Print Service software, where you can find new KODAK 
IMAGE MAGIC Custom Creations.



Initiates the KODAK IMAGE MAGIC Print Service software, where you can order your 
photographic-quality prints.



Type your own text to replace what's on the KODAK IMAGE MAGIC Custom Creations template.



Resets your search criteria to the initial settings. The Reset button then changes to Redo. Redo 
restores the changes.



Orients the page with the short edge to the top.



Orients the page with the long edge to the top.



Lists available page sizes. 



When Custom Size has been selected, you can increase or decrease the width of your page in 
small steps.



When Custom Size has been selected, you can increase or decrease the height of your page in 
small steps.



Closes the task pane and carries out the command.



Closes the task pane and cancels any changes you have made.



Proceeds to the next task pane.



Returns to the previous task pane. 



Selects a picture for a new e-mail postcard.



Opens an existing e-mail postcard.



Opens the e-mail postcard so you can see it.



Click this to select a path.



Initiates the search.



Each ball represents a different strength level for distorting your image. 



Color effects you can use. Click the arrows to see more.



Artistic effects you can use. Click the arrows to see more.



Special effects you can use. Click the arrows to see more.



Standard edge resolutions to choose from.



Opens a sound stored on your computer, a network, a disk, or a CD-ROM.



Type the name of the file you want to find.



Clears the file name you just typed. The Reset button then changes to Redo. Redo restores the 
file name.



Creates a greeting card that is folded twice vertically. Click this option to see a preview.



Creates a greeting card that is folded along the top, and also along the side. Click this option to 
see a preview.



Click to add your pictures to your Catalog.



Click to store your pictures elsewhere on your computer.



Pictures or folders you have selected.



Saves your e-mail postcard to be mailed later.



Initiates a search for your pictures in the folder or catalog you’ve selected. 



Enter numbers to adjust the position of the slider in small increments.



Standard edge designs you can use. Click the arrows to see more.



Click the arrow to choose from available resolutions.



Adds an artistic effect to your text. 



Adds a traditional look to your text. 



Adds an exotic look to your text.



Text effects to choose from. Click the arrows to see more.



Changes the color of your text. 



Changes the content of your text.



Makes a new cutout you can add.



Displays further help topics after scanning.



Does not display further help topics after scanning.



Lists the available folders for Picture It! to look in first when opening pictures. Select the folder
you want, and then click OK.



Downloading pictures from a new roll of film at PhotoNet
1 On the Workbench, click Get Picture, and then click My Picture.
2 Click the small arrow to the right of Click a folder, and then click PhotoNet.
3 In the list, click New PhotoNet roll, and then in the Internet message that appears, click 

OK.
4 If you are not currently connected to the Internet, your Internet service provider login 

screen will appear for you to establish the connection.
5 In Name, type your name, and in Film Id, type the film identification number you received 

from PhotoNet.
Note: The first time you view a roll of film at PhotoNet, a thumbnail of each picture will be 
stored on the hard drive of your computer.

6 To specify the resolution your picture will be downloaded at, click the small arrow to the right
of Picture quality, and then click Low, Medium, or High.
Note: If you choose High, you will be charged a download fee.

7 To select a picture to download onto your computer, click the thumbnail you want and drag it 
onto the Filmstrip.
Tip: To download more than one picture at a time, hold down CTRL and drag the thumbnails 
onto the Filmstrip.

8 If you are not being billed for the download and you see your picture on the Filmstrip, click 
Done, and then in the Internet logoff reminder message click OK.
Note: Picture It! will not log off your Internet service provider for you.
—or—
In the OK to Bill? message, click OK to proceed with downloading your picture to your 
computer.

          How can I reduce my PhotoNet charges?  
9 In the Billing Information Screen, type your name, address, telephone number, e-mail 

address, major credit card number, and credit card expiration date. If you want your credit 
card information to automatically appear next time you use PhotoNet, click Remember Credit
Card Information.

10 To process your billing information, submit a charge to your credit card, and download your 
picture onto your computer, click OK.

11 Click Done, and in the Internet logoff reminder message, click OK.
Note: Picture It! will not log off your Internet service provider for you.

Troubleshooting
          PhotoNet problems  

Tips
          What is PhotoNet?  
          What do I need to use PhotoNet's services?  
          Tips on reducing PhotoNet charges  



Downloading pictures from a roll of film that you've already 
viewed at PhotoNet
1 On the Workbench, click Get Picture, and then click My Picture.
2 Click the small arrow to the right of Click a folder, and then click PhotoNet.
3 In the list, click the film identification number you want, and then in the Internet message 

that appears, click OK.
4 If you are not currently connected to the Internet, your Internet service provider login 

screen will appear for you to establish the connection.
5 To specify the resolution your picture will be downloaded at, click the small arrow to the right

of Picture quality, and click Low, Medium, or High.
Note: If you choose High, you will be charged a download fee.

6 To select a picture to download onto your computer, click the thumbnail you want and drag it 
onto the Filmstrip.
Tip: To download more than one picture at a time, hold down CTRL and drag the thumbnails 
onto the Filmstrip.

7 In the OK to Bill? message, click OK to proceed with downloading your picture to your 
computer.

          How can I reduce my PhotoNet charges?  
8 In the Billing Information Screen, type your name, address, telephone number, e-mail 

address, major credit card number, and credit card expiration date. If you want your credit 
card information removed from the screen when you're done, click Remember Credit Card 
Information to remove the check mark.

9 To process your billing information, submit a charge to your credit card, and download your 
picture onto your computer, click OK.

10 Click Done, and in the Internet logoff reminder message, click OK.
Note: Picture It! will not log off your Internet service provider for you.

Troubleshooting
          PhotoNet problems  

Tips
          What is PhotoNet?  
          What do I need to use PhotoNet's services?  
          Tips on reducing PhotoNet download charges  



Saving your picture at PhotoNet
You can only save at PhotoNet the picture that is currently in the picture pane. To save more 
than one picture, open each one and repeat this procedure.
1 On the Workbench tab, click Save, Print, & Send, and then click Save As.
2 Click the small arrow to the right of Click a folder, and then click PhotoNet.
3 If you are saving your picture to an existing roll of film, in the list, click the film 

identification number you want.
—or—
Click New PhotoNet roll.

4 In the Internet message that appears, click OK.
5 If you are not currently connected to the Internet, your Internet service provider login 

screen will appear for you to establish the connection.
6 Click Save.
7 Type your name, telephone number, and e-mail address where indicated, and then click OK.
8 If you are not being billed for the upload and you see your picture in the picture pane, in the 

Images Remaining message click OK, and then in the Internet logoff reminder message click 
OK.
Note: Picture It! will not log off your Internet service provider for you.
—or—
In the OK to Bill? message, click OK to proceed with uploading your picture to PhotoNet.
Note: You will be charged an upload fee for the first picture you save to an existing roll of 
film at PhotoNet. For 30 days thereafter, you can save 5 more pictures to the same roll of 
film at no charge.

9 In the Billing Information Screen, type your name, address, telephone number, e-mail 
address, major credit card number, and credit card expiration date. If you want your credit 
card information removed from the screen when you're done, click Remember Credit Card 
Information to remove the check mark.

10 To process your billing information, submit a charge to your credit card, and upload your 
picture to PhotoNet, click OK.

11 In the Internet logoff reminder message, click OK.
Troubleshooting
          PhotoNet problems  

Tips
          What is PhotoNet?  
          What do I need to use PhotoNet's services?  



PhotoNet problems
What is the problem?
          I can't find my roll of film  
          I can't log on to PhotoNet  
          Missing or incorrect billing information  

For assistance, you can contact PhotoNet at:
Phone number:    1-888-FUN-PICS (1-888-386-7427)
E-mail: netpics@photonet.com
FAQ web page: http://home.photonet.com/faq/



I can't find my roll of film
Verify that the film identification number you typed was correct. If it is, call PhotoNet to locate
your film. 



I can't log on to PhotoNet
If you are connecting to the PhotoNet site with an external modem, make sure it is turned 

on, and all the cables are completely plugged into the correct outlets. 
If you are using an internal modem to connect, make sure the telephone line is securely 

plugged into the correct outlet.
If the PhotoNet site on the Internet is temporarily unavailable, try logging on again a little 

later.
Quit Picture It!, start Picture It! a second time, and try logging on to PhotoNet again.



Missing or incorrect billing information
Verify that you have typed correct information in the name, address, and credit card information
areas.



What is PhotoNet?
PhotoNet provides one more method for you to get your pictures into Picture It! and then share 
them with your friends and family members. 
PhotoNet digitizes the photographs on your rolls of film, and then stores these high-resolution 
images on the Internet. Many photofinishing companies now offer PhotoNet's service.
After PhotoNet has processed your pictures, you will receive an e-mail message with a unique film
identification number. With this number, you can:

View your pictures.
Download some or all of the pictures to your computer.
Send e-mail to a friend telling them how to view or download your pictures to their 

computer.
Store other pictures from Picture It! on this roll of film on the Internet.

For more information visit the PhotoNet Web site at:
http://www.photonet.com
Tips
          What do I need to use PhotoNet's services?  



What do I need to use PhotoNet's services?
Before you can request PhotoNet processing from a photofinishing company, you need:

A modem or network connection to the Internet.
An Internet service provider (ISP), such as MSN.
A major credit card for the billing charges. PhotoNet accepts VISA, MasterCard, American 

Express, and Diner's Club.



Tips on PhotoNet's charges
In addition to the processing fee, PhotoNet charges you a minimum fee for downloading pictures 
to your computer.
Each time you drag a high-resolution picture from PhotoNet to the Filmstrip in Picture It!, you 
will be charged a minimum download fee. Depending on the size of the image, you may also be 
charged for downloading a medium-resolution picture.
To reduce the cost of using PhotoNet, try:

Using medium or low resolution whenever possible
Experimenting to see how many pictures you can download at one time, and still stay within 

the basic charge. To find the maximum number of images you can download, click a single thumbnail 
in the preview pane, click Open, note the basic charge, and then click Cancel. Repeat this 
procedure, only this time hold down the CTRL and click two thumbnails to download. Continue in this 
manner, adding one more picture each time, until the billing charge increases.
The first time you add a picture to an existing roll of your film or create a new roll of film at 
PhotoNet, you are charged a minimum fee. You can then upload up to 35 more pictures without 
charge.



Using PhotoNet
What do you want to do? 
          Download pictures from a new roll of film  
          Download pictures from a roll of film I've already viewed  
          Store pictures at PhotoNet  



Downloading a picture from PhotoNet
What are you downloading?
          A new roll of film  
          A roll of film I've already viewed  




